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Fixing White Balance and Color Errors in Photoshop 
By Ron Carran 
August 17, 2007 
 

 
After shooting with your digital camera (of after scanning a piece of film), you will want to 
use Photoshop to fine-tune the colors and mood of the photos you took. Often, 
especially when shooting in raw format, your pictures will look a bit dull and washed out 
compared to the way they looked on the camera’s small LCD. This is entirely normal, for 
the camera is applying some fixes of its own to make to picture look “punchy” on the 
LCD, but the raw data awaits your manipulation to show its true “colors.” 
 
Photoshop offers you all the tools you need to accomplish your vision, but it requires a 
good deal of setting up before you can start adjusting, correcting and tweaking. Let’s 
start with that. 

Setting up your computer 

In order to be able to assess the color quality picture you are seeing on your computer 
screen, and make decisions about correcting its color, you need to make sure what you 
are looking at is actually what will print or display when you produce the final 
presentation copy of the image. We need to start by setting up your computer to a set of 
known calibration values, so that we can accurately judge what it is displaying. First, we 
will tell Photoshop which parameters to use in displaying color, then calibrate your 
monitor to display those colors, then finally move on to adjusting your printer match what 
you see on the monitor. 
 
Photoshop Color Settings 
You need first to tell Photoshop how to interpret colors, and what parameters to use 
when displaying those colors. The following steps will set up what I consider to be the 
most desirable settings for color rendition. There are many parameters you can change, 
but most of them can be set correctly by accepting the defaults.  
 
Use this procedure. 
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1. From the Edit menu, select Color Settings. The following window opens. (Make sure 
More Options has been clicked. (When it has, the button will say Fewer Options.) 

 
 

 
 
 
2. Choose North America Prepress 2 for the most widely used group of settings.  
 
 
Notice that the RGB Working Space is set automatically to Adobe RGB (1998). This is 
fine for most applications. Adobe RGB (1998) has become a standard in the prepress 
and imaging industry. However, if you have a newer printer (Epson, HP or Canon) and 
wish to print a larger gamut of colors, change this setting to Pro Photo RGB. Gamut 
refers to the set of colors displayable on a monitor (or printable from a printer). These 
newer printers are capable of accurately printing these colors, so you can take 
advantage of them by selecting this larger gamut working space. Many less expensive 
digital cameras use sRGB as their working space. This is a smaller gamut than Adobe 
RGB (1998), and is used widely for web graphics. So, if your intention is to use your 
photos mainly on the Internet, sRGB will give you a more realistic idea of how they will 
look in a browser. But for printing, Adobe RGB or Pro Photo is the better choice. 
 
Note: If you own the entire CS3 suite of programs (Photoshop, Illustrator, InDesign, etc.), 
you should synchronize the settings among all of these programs. 
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3. Select Creative Suite Color Settings from the Edit menu in Adobe Bridge.  
4. Pick the color settings you want to synchronize and click Apply. 
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Monitor Calibration 

Adobe provides software to do a manual monitor calibration for Windows called Adobe 
Gamma. This method will get your monitor in the “ballpark” of accurate color rendition, 
but that’s about all. It relies on your eyes as the judge of what colors are correct, which 
may or may not actually be accurate. On a Mac, use the Apple Display Calibrator, which 
works only for Apple monitors. (Note: many LCD monitors are calibrated differently than 
CRTs, and may not produce as accurate colors as CRTs.) 
 
A far better method is to use a third-party hardware calibrator to check exactly what 
colors the monitor is producing, and adjust them to the correct levels. These calibrators 
are available for prices ranging from about $79 to a few hundredi. I won’t go into the 
instructions to actually run the calibrations, as each manufacturer has their own 
procedure. 
 
Let’s assume that you have calibrated your monitor using one of these methods, and 
that you are actually seeing relatively correct colors when you look at one of your photos 
on screen. At least now you can make informed decisions as to how to change the color 
that you see, and be confident that, when displayed, your pictures will be close to what 
you had in mind. 
 
Printer Calibration 

The next step is calibrating your printer so that the final print also looks like what you 
saw on your screen. This step is critically important, but is actually not too difficult to 
perform. Actually, there are a number of steps. I will use Photoshop CS3 as an example, 
but earlier versions of Photoshop operate in similar ways (differences will be noted). 
 
First of all, printer calibration can only be carried out on today’s modern ink jet printers. 
Also, not all printers will calibrate successfully. As a general rule, any Epson, HP or 
Canon ink jet designated as a “photo” printer (and not an office printer), will be usable, 
with the higher-priced models being more successful. 
 
The process involves using a print profile, which is actually a data file produced either by 
the printer company, the paper company, or yourself, that tells the printer how to put 
down ink on the paper to match what’s on screen. The profile must be specifically 
produced for a particular printer/paper combination (e.g. Epson 2200 with Epson 
Premium Luster Paper). Only with that exact combination will the profile work. Use 
another manufacturer’s luster paper, and the results will probably be disappointing (or 
awful). 
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Here’s the procedure.  
 
1. Open the Photoshop Print Dialog box using File->Print (in CS3). (On earlier versions 

of Photoshop, you must use File->Print with Preview). 
 
 

 
 
 
This Photoshop CS3 dialog box makes it ease to see the order of what has to be done. If 
you think of the window as having 3 columns (picture, Printer, Color Management), just 
follow these columns from the top to the bottom. 
 
Note: Earlier versions of Photoshop have a different layout on their print dialog windows 
that CS3, but the functions are roughly the same. 
 
2. Select the orientation of the photo. 
3. Select your printer from the Printer drop-down list. 
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4. Now click Page Setup. 
 

 
 
5. Set your Format for Your printer and the Paper Size to the size sheet you want to 

print on. 
6. Set the Orientation and Scale. 
7. Click OK. 
 
You can leave all other settings in this column set to their defaults. 
 
8. On the Color Management panel, you make the important decisions. Select Color 

Handling to be Photoshop Manages Colors. 
9. Now select the Printer Profile for the type of paper you are using. 
10. Set the Rendering Intent (to Relative Colorimetric or Perceptual). 
11. Click on Black Point Compensation. 
 

 
 
 
12. Now click Print. 
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Set Print Settings by selecting the correct Media Type to your paper, Advanced Setup 

Print Quality to the desired value, and the Mode to the quality you want (High Speed 
off and Finest Detail on for best quality).  
 
 

 
 
 
Make sure you set Printer Color Management to Off (No Color Adjustment). This tells 
the printer not to adjust anything, as the profile in Photoshop will do all the work. 
 
 

 
 
 
13. Now Print your picture. 
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One last printer calibration that you can optionally do is to determine the tonal range of 
your printer. That is, how dark can your printer print without making totally black, or how 
light can it print where there is still dot visible. To do this, you can print these two files to 
give you an idea where your printer starts printing actual dots from pure white (R, G & B 
values of 255,255,255 don’t print any dots), and where you start to see a change from 
pure black (R, G & B values of 0,0,0 prints full black, do visible dots). We’ll use these 
values to set up Photoshop’s White and Black limits. 
 
 
14. Print these out and note the values that you begin to see dots, black and white. 
 
 
 

 

 

 



Color  Westchester Photographic Society August 17, 2007 

 Page 9 of 22 

Making Photoshop Color Adjustments 

Now that we know that the displayed print will look like what we set on the screen, we 
can start to make artistic decisions. These decisions include portraying colors accurately 
(assuming that is what you want to do), having a suitable amount of contrast in the 
photo, removing any color cast, setting neutrals, adjusting highlights and shadows, and 
sharpening the finished product.  
 
We are going to assume that all of your output will be in RGB mode, for use in ink jet 
printers, and not CMYK, used for commercial web press or lithographic printing. CMYK 
presents you with a large set of problems that we don’t have to deal with for desktop 
printing. 
 
Let’s set up the white and black limits for Photoshop to use when determining the black 
and white points of a photo. 
 
1. Open any image, even a new blank one. 
2. Click Cmd-M (PC: Control-M) to open the Curves dialog box. 
 
 

 
 
 
1. Double-click on the left (black point) eyedropper. 
2. Set the R, G & B values at whatever levels you selected from the black point test 

print (I use 7,7,7). 
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3. Click OK. 
4. Double-click on the white eyedropper and set your RGB values accordingly, either 

from your test print or use mine (247,247,247). 
 

 
 
The gray-point (middle) eyedropper is fine to leave at 128,128,128. 
 
5. Click OK. 
6. Exit the Curves dialog by clicking OK. When asked if you want to use these values 

as defaults, click Yes. 
 
 
 
Correcting Colors 

Now let’s do some correction. 
 
Many of us shoot raw format, so let’s start by using Adobe Camera Raw to create a 
workable Photoshop file to correct. There are many adjustments that can be made in 
ACR, enough to fill an entire book, but let’s concentrate on Photoshop’s tools for now. 
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1. We’ll start by clicking Open in ACR to place this picture into Photoshop, as a .PSD. 
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One place to start is by identifying the lightest and darkest places in this photo. We want 
only meaningful selections, not specular (reflections) highlights or minute dark places 
practically hidden from view. We also want to look for neutral areas, places we know that 
should be gray. Let’s start with whites and blacks. 
 
2. Click the adjustment layer icon at the bottom of the Layers palette and select 

Threshold. 
3. Slide the pointer first to the right (A) to find the whitest points, then to the left to find 

the darkest. 
 
 
 

 
 
 
 
 
1. Place a white point Color Sampler by selecting the white point eyedropper from the 

Curves dialog box, then shift-clicking on the sampler you placed on the whitest point 
on the picture.  

2. Do the same using the black point eyedropper to the color sampler placed at the 
picture’s darkest area. 

 

Fig. A Fig. B 
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The results are quite dramatic. Just by adjusting what we know should be white and 
black, many of the colors in the photo fall right into line. 
 
 

 
 
 



Color  Westchester Photographic Society August 17, 2007 

 Page 14 of 22 

Using the gray eyedropper can also make a big difference in any colorcast present in a 
picture. This next photo has a definite Blue-green cast to it. But I know that the door in 
the photo should be gray, so if we click the gray eyedropper from the curves palette on 
the door, the overall colorcast of the picture should be reduced, and the other colors in 
the picture should be truer. 
 
 

 
 
 
 
 
And that’s what happens. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2002 Andy Katz 
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Let’s return to Adobe Camera Raw and see what we can do to change the white balance 
of a photo, before we take it into Photoshop. 
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By adjusting the White Balance to Shade (7500°K1), increasing the Exposure (+1.20 
stops), Recovery (from 5 to 8 to bring back the white point a little), and Blacks (up from 5 
to 16 to move the blacks darker), we come up with a much more balanced picture. Now, 
when we move this into Photoshop, we can concentrate on the details. 
 
 
 
 
 

                                                
1 °K refers to degrees Kelvin, a way that the color of light is measured. This following definition is from 

Wikipedia: “Color temperature is based upon the principle that a black body radiator emits light whose color 
depends on the temperature of the radiator. Black bodies with temperatures below about 4000 K appear 
reddish whereas those above about 7500 K appear bluish. Color temperature is important in the fields of 
image projection and photography where a color temperature of approximately 5500 K is required to match 
“daylight” film emulsions.” When you decrease ACR s color temperature, you are compensating for the lower 
(reddish) temperature of the ambient light, and it does the opposite when you increase the temperature. This 
is a bit counter-intuitive, since a higher °K is actually bluer (as in super-heated). 
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Shooting for Balance 

You can practice a technique that will make the pictures you capture in the camera 
easier to color correct and adjust. It works best with portraits either inside or out, but will 
help in any controlled situation. It involves taking a picture of a calibrated color chart, 
such as the GretagMacbeth ColorChecker .  

 
Here is a picture with a portrait subject holding the color chart. Assuming you take this 
picture in the same light that as another group of pictures are taken in, you can perform 
the major color correction tasks all in one shot, using just this photo. Then apply the 
same adjustment to all of the photos shot in this environment (e.g. with an action). 
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Notice that we have placed color samplers on the gray(1), black(2) and white(3) patches 
on this calibrated chart. Now all we have to do is use the gray, black and white 
eyedroppers in the Curves dialog to set these colors. Like magic, the picture takes on a 
completely different look (and a better one). 
 
 

 
 
 
There is a lot more to talk about concerning color correction, especially when we start 
adjusting skin color, and photos that don’t have defined white, black or gray areas in 
them. There are a number of books dedicated to these tasks, but a few that I 
recommend, and will help with the basics are noted at the end of this article. 
 



Color  Westchester Photographic Society August 17, 2007 

 Page 19 of 22 

Adjusting Skin Tones 

Skin tones are usually the hardest colors to correct, mostly because they are not 
uniform, and the tonal differences can be subtle. Graphic artists and photographers have 
been correcting skin tones for years, mostly for use in magazines and advertisements, 
and they have worked up a number of formulas to describe how to adjust these colors.  
 
To make things slightly more complicated, they have been doing this correcting mostly in 
the CMYK color space, not RGB. The reason is that commercial printing uses a different 
process for producing images than our inkjets do. They use a collection of ink dots called 
a halftone. Since commercial printing ink is opaque, the 4 colors C)yan, M)agenta, 
Y)ellow and K)Black must be arranged near each other to give the impression of a full 
range of colors. Three of those inks (C,Y,M) make a dark brownish-black when placed in 
a halftone dot in equal amounts. Black is added for a real black. Inkjet printers, on the 
other hand, use a wide variety of inks that combine to produce other colors, including 
CMYK, although they print using your RGB files (not CMYK). 
 
With all that said, it is probably better to correct skin tones using CMYK numbers instead 
of RGB. Here are some numbers and formulas you can use to correct in CMYK. 
 
Skin Types  CMYK Values  Light-skinned Babies 
Light Baby  C 0  Y should be about = to M 
   M 15   
   Y 15 
   K 0 
      Adults 
Avg. Caucasian C 8  Y should be 1/5 to 1/3 > M 
   M 35  C should be 1/5 to 1/3 < M 
   Y 45 
   K 0 
 
Tanned Caucasian C 15 
   M 49 
   Y 68 
   K 0 
 
Darker Skin  C 27  Black should only appear 
   M 50  in darker-skinned people 
   Y 63  C should be about  of M 
   K 21 
 
Very Dark Skin C 47 
   M 50 
   Y 63 
   K 55 
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Katrin Eismann has come up with a very good way of doing CMYK correction without 
having to convert your photos into CMYK (which is to be avoided, if possible). Here is 
the technique. 
 
1. Open the photo in Photoshop. 
2. Click Image/Duplicate to create a copy of the image. 
3. Change the mode of the duplicate to CMYK by clicking Image/Mode/CMYK Color. 
 

 
 
Correct the duplicate using the formulas on page 19. Here’s what I did. 
 
4. Place a color sampler on the woman’s face (by Shift-Clicking on the Eyedropper 

tool). This sets an area of the following values: C: 23%, M: 35%, Y: 35%, K: 0% (your 
values may differ slightly depending on where you clicked. I tried to click on an 
average part of the face, not where the highlight or dark area was). 

 
Adjust these values by using the Curves palette in the following way: 
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5. Add a Curves adjustment layer by clicking on the half-circle icon at the bottom of the 
layers palette. 

6. Change the Channel to Cyan. 
7. Command-Click (PC: Ctrl-Click) on the place where your color sampler is, and a dot 

will appear on the Curves histogram where that color is. 
8. Change your Output Level to 12. 
9. Change the channel to Magenta, and do the same but change the Output Level to 

42. 
10. Change the channel to Yellow, and do the same but change the Output Level to 50. 
 
These numbers are between a normal Caucasian-skinned person and one with a darker 
tan. 
 
11. Click OK. 
12. Click Layer/Flatten Image from the menu. 
13. Press Cmd-A (PC; Ctl-A) to select the entire image. 
14. Press Cmd-C (PC; Ctl-C) to copy the image to the clipboard. 
15. Click on the original image and press Cmd-V (PC: Ctl-V). 
16. Send the Background layer to the trash bin at the bottom of the Layers palette. 
 
You now have an RGB image that was corrected in CMYK, and we haven’t altered any 
pixels in the process. Doing skin correction takes experimentation and practice, but 
using these formulas will help get you to a fairly acceptable result. 
 

 
 
There is a lot more you can read up on, and I have put a list of books on the next page 
top consult. 
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i Hardware calibrators: 
 
Pantone Huey $89 (www.pantone.com) 
ColorVision Spyder2 $79 to $249 (www.colorvision.com) 
xRite i1Display $169 to $498 (www.xrite.com) 
 

Books on Color Correction 

 

Photoshop Color Correction by Michael Kiernan 
Peachpit Press 2003  ISBN: 0-321-12401-4 

 
Photoshop PS2 Studio Techniques by Ben Willmore 
Peachpit Press 2006  ISBN: 0-321-32189-8 
 
Professional Photoshop: The Classic Guide to Color Correction (5th Edition) 

By Dan Margulis  Peachpit Press 2006  ISBN-13: 978-0321440174 
 
Adobe Photoshop Restoration & Retouching (3rd Edition) by Katrin Eismann 

New Riders Press; 3 edition 2006  ISBN-13: 978-0321316271 
 


